# Table of Contents

1.0 Overview .................................................. pg. 2-3  
2.0 VSP Wing Structural Definition ...................... pg. 4-13  
3.0 Running VSP SAM ........................................ pg. 14-36  
4.0 Limits and Constraints .................................. pg. 37-38  
5.0 Load Case Methodology ................................ pg. 39-41  
6.0 Thickness Sizing Methodology ....................... pg. 42-43  
7.0 Mass Generation Methodology ....................... pg. 44  
8.0 Appendix .................................................. pg. 45-48
1.0 Overview

1.1 Introduction. Substantive engineering application of Finite Element Methods (FEM) of structural analysis to conceptual design (CD) has been limited\(^1\). Some reasons are well known; FEM design and analysis depends on definition of internal and external geometry, and internal details not typically available during CD. Other reasons are less well-known including data latency and staffing constraints. Regardless, the outcome is that CD projects typically defer substantive FEM analysis until Preliminary Design (PD) and sometimes later. As a consequence, significant structural issues associated with otherwise well-designed concepts may not surface until late in a program.

The Air System Laboratory at the University of Texas at Austin (UT) with support from NASA Langley Research Center has been involved in methodology research and development for the Vehicle Sketch Pad (VSP) structural analysis module since 2009. The effort has resulted in development of an enhanced conceptual-level structural design capability that has been applied to representative transport aircraft wings\(^2\). The initial objective of the research was to provide conceptual and preliminary air vehicle designers with high-fidelity, user-friendly structural analysis methods applicable to a fast-paced conceptual design environment. The end objective, however, is to apply FEM design and analysis methods to structural mass property estimation. FEM based methods are expected to generate higher-fidelity estimates than are possible with current regression based mass estimation parametrics. The focus of the associated software development effort is the VSP Structural Analysis Module (VSP SAM), a user-friendly FEM interface for CD phase structural analysis and mass property estimation.

1.2 VSP SAM consists of a set of UT developed JAVA Scripts that prepare VSP output files for input to the CalculiX FEM solver and post-process CalculiX output for user evaluation and mass calculation. It is compatible with VSP version 2.1.0 and CalculiX version 2.3 for Windows. The primary function of VSP SAM is to facilitate CD-level FEM structural analysis and mass estimation without requiring in-depth FEM tool-specific user knowledge. Once the user has completed the definition of required inputs, VSP SAM runs through all pre-processing tasks, executes CalculiX calculates FEM thickness required to achieve an input static stress sizing objective, and generates a FEM-based mass estimate, all with a single click in the GUI. As a result, CD-level users now have a capability to do high-fidelity structural analysis during CD with data preparation and turn-around times measured in minutes instead of days and weeks.

Included among the tool-specific processes simplified by VSP SAM are the importation of VSP structural mesh data files, user-definition of load and boundary conditions, initial thickness and component material definitions, structural box “trim” definitions and export of the results to CalculiX as an input file.

Consistent with current VSP wing structure capabilities, VSP SAM is limited to analysis of single swept trapezoidal (including rectangular) wing planform geometries. Boundary conditions are defined for user input rib pairs that restrain translation and rotation in the appropriate x-y, y-z, and z-x planes. Spars, ribs, and skins can be assigned different material properties including minimum gauge and design stress objectives. Loads are defined by traditional linear, elliptical, or Schrenk approximations applied along a constant chord line or by discrete point loads. In its current form VSP SAM does multiple CalculiX iterations to converge on user defined Design Nominal Stress and calculate a FEM-based mass estimate for a user-defined mass convergence criterion and von Mises design stress objective. The mass estimate is based on a volume calculation of a thickness resized FEM model where nodal thickness is sized to achieve a user input design stress objective for the part class (spar, rib, or skin). The mass solution applies a user input minimum gauge criteria to limit calculated thickness to realistic values.

1.3 NASA’s Vehicle Sketch Pad (VSP) parametric air vehicle CAD system is the enabler for VSP SAM. VSP has a parametric geometry model, architecture, and every time a design change is made, a new geometry database is automatically generated. This fundamental architectural feature allows VSP to facilitate rapid configuration development, and even more importantly, to accommodate rapid change. Once a VSP configuration is generated (or uploaded), the VSP Wing Structural FEA module automatically links to the wing model to enable parametric placement of wing spars, ribs, and skins. After defining the components, the user defines a mesh element size and VSP computes and exports a compatible mesh that is post-processed by VSP SAM as described in 1.2 above.

Note to users – The VSP FEA module requests user input of material thickness and densities but they are not used by VSP SAM and can be ignored.

1.4 CalculiX is an open-source 3-D finite element method program from the Free Software Foundation. CalculiX is a good tool, but it is complex for non-FEM specialist users. Achieving proficiency on input file conventions and preparing input data is time-consuming and CalculiX tool specific; therefore, one objective of VSP SAM is to push CalculiX tool specific processes into the background and to translate otherwise arcane FEM input requirements into user-friendly terms. CalculiX FEM analysis generates a variety of stress, strain, force, and displacement outputs including von Mises stress maps. The CalculiX output file structure and interactive tool set is reasonably user friendly for CD-level users and required no VSP SAM code development except that required for FEM mass calculation and, for later releases, static stress-based sizing solution iteration.

---

3 Schrenk, O., “A Simple Approximation Method For Obtaining the Spanwise Lift Distribution”, NACA TM 948, Apr 1940
6 Anon, CalculiX, A Free Software Three-Dimensional Structural Finite Element Program, http://www.calculix.de/
2.0 VSP Wing Structural Definition

2.1 Advanced Composite Technology (ACT) Wing Model. The geometry for the example used in this users guide is based on a previous NASA supported McDonnell-Douglas (now Boeing) wing design for the NASA Advanced Subsonic Technology program. The ACT wing structural geometry drawing is shown below in Figure 2.1. The original wing was constructed using advanced graphite–epoxy materials and manufacturing techniques. For the purposes of simplicity, the ACT Wing is approximated as a single section wing trimmed to a simple wing box. This is necessary because the VSP structural module is currently limited to single swept trapezoidal planform wing geometry. The ACT wing structure is shown below.

Figure 2.1: Original drawing depicting ACT wing box structure.

Note to users – Due to the extensive use of graphics in this section, the page layout groups task specific instructions and graphics on a single page. The layout approach results in gaps at the bottom of many pages but hopefully makes the guide easier to use for design and analysis.

2.2 Creating the VSP Model. For the purposes of explanation in this section, The ACT wing model used for the users guide example was imported as a JPEG (.jpg) template and flipped longitudinally to represent a starboard wing (note the text reversal). JPEG template input is not a requirement; a viable VSP SAM model can be generated by any design technique available to VSP users.

*Note to users:* VSP only accepts JPEG (.jpg) image files. *Using any other image file extension will result in a program crash.*

2.2.1 Import the background image ACT JPEG Template as shown below in Figure 2.2:

a. The Background menu is reached through: Window > Background.

b. A JPEG Image can be chosen by clicking on “JPEG Image” and selecting a file in the resulting file browser window.

c. The Background window also has several options to move (“X Offset” & “Y Offset”) or resize (“W Scale” & “H Scale”) the image according to user preference.

d. In order to scale the image, “W Scale” or “H Scale” sliders can be used. Be sure to check the “Preserve Aspect” checkbox in order to preserve the template Height and Width ratio.

![Figure 2.2: The background selection Window (Left) and the background template picture of the ACT wing (Right).](image-url)
2.2.2 In the Geometry Browser Window, select “MS WING” from the top dropdown menu and then select “Add”, as shown in Figure 2.3 (Left):

e. In order to position the wing with the background, press “F5” key or go to view > Top (F5).

f. Click on the MS_Wing_0 that appears in the selection window to open the “Multi Section Wing Geom” Window.

2.2.3 Now in the Multi Section Wing Geom Window:

g. In the “Sect” tab, delete all but a single section of the wing (so only Sect 0 will be left). Also, adjust the sweep so that the VSP wing and template wings have the same leading edge sweep. For the ACT example it is 28.5 deg. As shown in Figure 2.3 (Center).

h. In the “Dihed” tab, define dihedral (zero for the example).

i. In the “Plan” the ACT wing span is set to 115.3 ft as shown in Figure 2.3 (Right). The background image used shows the swept span of the semi-span wing box, where the wing box sweep is found to be approximately 28.5 deg. (by method in step g). The total wingspan can then be calculated from this information.

Figure 2.3: Geometry Browser (Left): Select part to bring up the Multi-Section Wing Geom (Center and Right); Section tab (defined for semi-span): Sections can be added or deleted and sweep can be adjusted (Center); Planform tab: Total span of the wing is adjusted (Right).
2.2.4 In the window displaying the wing:

j. Use the mouse to position the wing over the background template picture, and zoom such that span of the VSP wing and the template wing match as shown below in Figure 2.4. Note that the VSP wing model is aligned span-wise with the inboard rib of the ACT wing consistent with current VSP wing structure limitations to single section, trapezoidal and rectangular wing planform geometries.

Figure 2.4: The wing adjusted to the correct span and laid on top of the background template.
2.2.5 In the Multi-Section Wing Geom window shown in Figure 2.5

k. In the “Sect” tab, set “Section Planfrom” to “Span-TC-RC”.

l. Adjust the “TC” and “RC” sliders so the VSP wing matches the background template wing.

m. DO NOT adjust the span (this was set in step 2.2.3 and should already be correct).

n. The ACT wing has a supercritical airfoil section. In the “Foil” tab, select “Read File” and select the “sc2_0404” airfoil from the airfoil file downloaded with VSP as an approximation. Do this for airfoil 0 (root) and airfoil (tip) and increase the airfoil 0 and airfoil 1 thickness to chord ratios (“Thick” slider) to 0.1. If greater detail in airfoil selection is desired, create a new airfoil file, as outlined in the general use VSP manual.

The final wing section and airfoil definitions are shown in Figure 2.5

Figure 2.5: The defined wing section menu and the airfoil selection menu.

o. The finished wing geometry is shown in Figure 2.6 on the next page.
2.3 **Save the model:** Go to File > Save or File > Save As.
2.4 VSP Wing Structure Definitions.

Open the “Wing Structure” menu in the Geom tab in the display screen. The wing structure menu options are shown below in Figure 2.7.

p. Under “Spars” add the number of spars to be defined (3 for the ACT example).
q. Position spar 0 at a chord fraction line along which loads will be applied. Conceptual level loads are typically defined along the quarter (0.25) chord but it is defined as a spar in the VSP model even if it does not physically exist. Therefore, in the materials input section (see 3.6), a capability is provided to define a loading spar that is not load carrying as “paper” to ensure that it does not carry loads.
r. For spar 1, click “Rel” for the spar sweep and adjust the position slider to align the spar with the background image forward spar.
s. For spar 2, click “Rel” for the spar sweep and adjust the position slider to align the spar with the background image aft spar.
t. Under “Ribs”, add the appropriate number of ribs and align them with the background template in the same manner as the spars. Ribs should be in numerical order, beginning with the 0th rib at the root and numbered sequentially going outboard.
u. Check relative or absolute sweep as appropriate and adjust it accordingly.

Figure 2.7: Spars and Ribs are added by clicking the indicated buttons. Also note the area used to adjust the element size.
Check in model with the background image. The model with the wing structure defined is shown below in Figure 2.8.

2.5 **Save the model**: Go to File > Save or File > Save As.

2.6 Define, generate and export the mesh.

2.6.1 While still in the Wing Structure window:

w. Set the Default Element Size to desired size. A smaller mesh size results in a more accurate analysis, but will increase runtime and/or crash fail depending on computer specs. Here, we will set the default element size to 1.0 ft.

x. VSP 2.1.0 allows the user to also define the minimum element size, maximum gap between elements, num circle segments, and growth ratio option to refine the mesh. These are used to define the curvature based mesh\(^8\).

---

y. Select “Compute Mesh”.
   i. VSP will generate the mesh. Depending on the wing, mesh size, and your computer specs, this can take less than a minute or several minutes.
   ii. The thickness extends inwards and outwards from the mesh surface. This should be taken into account when generating the wing model in VSP.
   iii. Upon completion, inspect the mesh to ensure there are no odd meshing errors. If there are, select a smaller element size and try computing the mesh again. See Figure 2.9 for an example of a faulty mesh.

![Figure 2.9: A mesh with failure in the spar mesh generation.](image)

z. Select “Export Mesh”.
   i. During this step, leave the default paths as they are and make sure that the geom and thick files are selected for export. Use the default format Wingname_calculix_geom.dat and Wingname_calculix_thick.dat

   where Wingname is the name of the .vsp model saved, or whichever name is specified in VSP. The name used should be noted for later use (note that when the VSP model is saved, the default name remains “VspAircraft”). Once the file is closed and reopened, the default file name is changed to the saved .vsp file name. Check the name before continuing to verify that the correct wing is run.
   ii. If you have trouble in the external structural module, check to ensure that the file destination is set to the module folder defined at the start of VSP SAM. The default export path is the folder where VSP is located. If the file is moved, a new path should be specified for the run.
2.6.2 Some computers may have problems generating a mesh for such a complex structure. In that case, a simplified version may be used, as shown below.

Figure 2.10: A simplified version of the ACT wing model: Internal structure definition (Right), With FEM mesh generated (Left).

2.7 The VSP model is now complete. The VSP file is ready to run in VSP SAM and generate a CalculiX solution and a FEM based mass estimate.
3.0 Running VSP SAM

3.1 Introduction – The primary function of VSP SAM is to facilitate CD-level FEM structural analysis and mass estimation without requiring in-depth FEM too-specific user knowledge. VSP SAM does multiple Calculix node thickness iterations to (1) converge to a user defined Design Nominal Stress and (2) calculate a FEM-mass estimate based on a user defined mass fraction convergence criteria. Figure 3.1 provides an overview of how VSP SAM works. VSP (section 2.0) is used to define the internal and external geometry and generate a mesh model. Other FEM definitions (section 3.0) including trim out of non-primary load carrying structure, definition of loads cases, etc., are made using UT developed GUI inputs. The input session concludes with a run command and the rest of the solution is essentially automatic. The process includes multiple Calculix solutions used to converge node thickness to meet the user defined Design Nominal Stress criteria. An input mass fraction difference criterion is used to define FEM-mass convergence.

Figure 3.1: VSP SAM functional overview.
3.2 Installation Instructions.

1. Download the VSP Structural Analysis Module (*VSPSAMXcute_1_1.zip*) from the VSPSAM website (http://vspsam.ae.utexas.edu). The file will include executables for VSP and CalculiX, a JAVA Development Kit (JDK), and a VSPSAM executable. Once downloaded, run the “Install.bat” file to install CalculiX and JDK. Use the default locations for installation simplicity. A ReadME file provides more detailed information if needed.

   *NOTE: changes made in each version are listed on the VSPSAM website (http://vspsam.ae.utexas.edu).*

2. Once the programs are successfully installed, click on *VSPSAMXcute.exe* and a GUI will pop up.

3. If you already have a wing model created with mesh files exported, you can run those files from the folder.

4. Details on running VSP SAM using GUI inputs is provided in the following sections.
3.3 Initial GUI Definitions:

VSP SAM makes extensive use of Graphical User Interface (GUI) inputs as shown in Figure 3.2. The Wing Geometry tab shown on the left is used to define geometry and trim options for a new session with no prior inputs. The tab also provides the user with status on where VSP SAM is in the computational process after hitting the run button. Other tabs are used to define new trim, initial thickness, material properties, and load cases. Previous VSP SAM session inputs can be input and current sessions can be saved as described below:

**Open Tab:** Use GUI inputs from a previous session, press the Open button. Use the drop-down menu to find the input file directory then select the input file.

**Save Tab:** Save GUI inputs from current session, press the Save button. Use the drop-down menu to find the current directory. Then overwrite the input file or create new input file.

**Radio Button:** A GUI icon that lets the user select a predefined option. Example - one of the "Side" buttons in Figure 3.2

![Figure 3.2: Initial GUI Options: GUI (Left). Use previous inputs (Top). Save current inputs (Bottom).](image)
3.4 **Top Level Inputs:** The toolbar is used to define the file locations and properties. The buttons at the bottom are to run or stop the program after the inputs are defined.

*Wing Path Tab:* Use the drop-down menu to find the working folder where VSP mesh is exported. This should correspond to the name of the model saved in VSP. In VSP, if the model was saved but never closed before mesh generation and exportation, the default name “VspAircraft” is used. Once the saved file is closed and re-opened and the mesh is generated, the mesh will be saved with the saved name of the model. Select any of the three files that contain the name of the wing. This simultaneously sets the directory of the working folder. The three files for this example are “ACTWingSimplified.vsp”, “ACTWingSimplified_calculix_geom.dat”, or “ACTWingSimplified_calculix_thick.dat”.

*CalculiX Path Tab:* Use the drop-down menu to determine the path to the location where CalculiX is installed on your computer. The default path shown corresponds to the default installation location.

*Run Button:* After all inputs have been made, click the run button to start.

*Stop Button:* Ends the program.

---

**Figure 3.3:** GUI window (Left), Wing Path (Top), and CalculiX Path (Bottom).
3.5 Trim Options: The trim option allows users to trim out control surfaces and other devices that do not carry wing primary loads, and skin sections to not transfer the primary loads. After the wing is trimmed, loads associated with the control surfaces or devices can be applied at a defined attachment location. The trim method can trim chord-wise and span-wise, but it is limited to trimming between ribs and forward or aft of the spars. The user can define a leading edge (LE) and trailing edge (TE) spar from which the user can choose to trim the entire leading or trailing edge of defined rib numbers between which to trim. The trim results can be seen in the CalculiX results in Figure 3.4 for trimmed devices and Figure 3.5 for trimmed skin sections.

Figure 3.4: Untrimmed ACT Wing (Left), Entire LE and TE device trim (Center), and Entire LE device trim and two TE trimmed devices (Right).

Figure 3.5: Example (not ACTWing) Upper and Lower skin trim.
3.5.1 The Device Trim GUI inputs are shown in Figure 3.6.

_Sides_: Under Device Tab choose the “Leading Edge” (LE) Radio Button for LE trim conditions or “Trailing Edge” (TE) Radio Button for TE trim conditions.

_Device ID_: If the LE is chosen, than the Device ID informs the user of the number of devices for trim and that device’s parameters, likewise of TE. There is essential an infinite number of devices the user can input.

_Spar_: Specifies the number of the forward spar (LE) or aft spar (TE) for the trim conditions. The input values should correspond to the VSP spar number of the LE and TE trim (between 0 and the maximum spar number). There is no requirement that the LE spar must be the forward-most spar included in VSP or that the TE spar must be the aft-most spar included in VSP, but this is generally the case. The input TE spar must be different than the input LE spar.

_Inboard/Outboard Rib_: Input starting/ending rib number for the device. The starting rib is the inboard rib of the device, and the ending rib is the outboard rib.

_Add Device Button_: Once the user is done with the trim conditions and the loading parameters (loading will be discussed under the loading options), then the user can press the add button to input another device.

_Delete Device Button_: If the user input too many devices or one of the device’s parameters is wrong, then the user can delete the device with the delete button and remove it or redo it.

![Figure 3.6: Trimming inputs for LE and TE from example in Figure 3.4 (Center).](image-url)
3.5.2 The Skin Trim GUI inputs are shown in Figure 3.7.

*Sides:* Under Wing Geometry Tab choose the “Upper Surface” Radio Button for upper skin trim conditions or “Lower Surface” Radio Button for lower skin trim conditions.

*Skin Trim ID:* If the Upper Skin is chosen, than the Skin ID informs the user of the number of skin sections for trim and that skin section’s parameters, likewise of Lower Skin. There is essential an infinite number of skin section trims within the forward-most spar and aft-most spar the user can input.

*Inboard/Outboard Spar:* Input starting/ending spar number for the skin section. The starting spar is the inboard spar of the skin section, and the ending spar is the outboard spar.

*Inboard/Outboard Rib:* Input starting/ending rib number for the skin section. The starting rib is the inboard rib of the skin section, and the ending rib is the outboard rib.

*Add Skin Trim Button:* Once the user is done with the trim conditions, then the user can press the add button to input another skin section.

*Delete Skin Trim Button:* If the user input too many skin sections or one of the skin section’s parameters is wrong, then the user can delete the skin section with the delete button and remove it or redo it.

Figure 3.7: Skin trim inputs for Figure 3.5.
3.6 Initial Thickness and Boundary Condition: User input of structural thickness is required to define a CalucliX FEM stiffness matrix. The GUI, shown in Figure 3.8, input thickness for the baseline CalucliX solution, which are defined parametrically. The parametric thickness definitions for spars, ribs, and skins vary linearly along the span; therefore, only two (2) thickness inputs are required per component. After the first CalucliX solution, new spar, rib, and skin thicknesses are calculated to achieve an input design nominal stress objectives by component. The second set of thicknesses is calculated node by node using methodology described in Section 6.0. Figure 3.8 shows the GUI inputs associated with the initial thickness definitions.

*Root Thickness:* The thickness of the component at the wing root; defined for the spars, upper skin, lower skin, and ribs. Thickness must be in model consistent units. Thicknesses along the span for these components are interpolated between the root thickness and the tip thickness.

*Tip Thickness:* The thickness of the component at the wing tip; defined for the spars, upper skin, lower skin, and ribs. Thickness must be in model consistent units. Thicknesses along the span for these components are interpolated between the root thickness and the tip thickness.

*Fixed Rib Number:* The VSP rib number defined as the fixed rib. The fixed boundary conditions is applied at a user defined inboard rib to approximate wing attach structure. The boundary conditions restrain translation and rotation at the rib.

*Convergence Criteria:* The convergence tolerance defines the difference between each iteration’s mass calculation.

![Figure 3.8: Initial Thickness GUI inputs.](image-url)
3.7 Material Properties: The materials section in the GUI, shown in Figure 3.9a and repeated in Figure 3.9b, allows input of up to four different kinds of materials. Materials are defined by material name, Young’s Modulus, and Poisson’s Ratio. One of the defined material types is applied to each of four structural component types (skins, spars, ribs, and load spar). Future VSP SAM releases will include additional material and structural component options.

Figure 3.9a: Material Properties GUI inputs.
3.7.1 Materials:

*Material (1-4):* Define up to four different materials. Only the materials defined for the spars, skins, ribs, and loading spar are necessary. Currently all four materials must be defined otherwise an error will occur, repeated material will not affect the program as long as it’s the same definition.

*Material Name:* Input the name of the material to be defined. This name is used when specifying the material used for the spars, skins, ribs, and load spar.

*Poisson’s Ratio:* The Poisson’s Ratio corresponding to the associated material (1-4). Can be any value desired, should be in units consistent with model.

*Yield Stress:* The yield stress corresponding to the associated material (1-4). Can be any value desired, should be in units consistent with model.

*Ultimate Stress:* The yield stress corresponding to the associated material (1-4). Can be any value desired, should be in units consistent with model.

*Note –* As described in section 2.4, a “loading spar” is defined as a spar in the VSP structural model whether or not a spar is physically located along the line where loads are applied. One of the four materials, therefore, is defined as “paper” and is intended for use as a loading spar that does not physically exist or carry loads. With the exception of this type of loading spar, all materials are assumed to stay within the linear elastic range. Note: the paper spar option is provided to allow users to introduce line loads directly into skin structure. The line load will be correctly introduced into the model but the displacements along the line can become unrealistically large. A more realistic approach is to introduce loads along a defined spar. Subsequent versions of VSP SAM will provide users an option to fractionally spread a load across multiple spars.
### 3.7.2 Define Components:

**Material:** Specify the type of material for each component (spars, skins, ribs, and load spar). Components must use one of the material defined above (Material 1-4).

**Allowable Stress:** The design nominal static stress objective for a class of structural components (spar, ribs, skins, or load spars), e.g., X ksi for spar, Y ksi for ribs, etc. Units must be consistent with input geometry.

**Density:** Define the density of the material to be used for mass calculation. Can be any value desired but must be in units consistent with the VSP model.

**Minimum Gauge:** Define the minimum allowable thickness for the material. Can be any value desired but must be in VSP model consistent units. Note: Selecting excessively small values can create significant solution stability issues.

![Material Properties GUI](image)

*Figure 3.9b: Material Properties GUI (repeated for convenience).*
3.8 Load Cases. Loads can be applied on the top or bottom surfaces of the wing.

3.8.1 Load Types: Seven types of design load cases are currently provided. As summarized below, three (3) represent distributed 2-D loads applied along a constant chord fraction line from root to tip. The constant line is defined as a loading “spar” and is typically located along a 25% chord line. The 4th type is a set of discrete point loads that can be defined at any number of span and chord fraction locations. The 5th type is for loads applied on or along the front and rear spars at previously trimmed locations.

1. Linear wing load – distributed load varying linearly from wing root to tip.
2. Elliptical wing load – theoretical symmetric elliptical wing load defined by vehicle weight and load factor.
3. Schrenk’s wing load approximation – symmetric elliptical and planform are averaged running load, also defined by weight and load factor.
4. User-defined point loads applied at any number of span and chord fractions. Loads are defined normal to the surface.
5. Constant distributed loads and/or point loads along a front and/or rear spar are intended to represent loads from leading and/or trailing edge devices trimmed out (Section 3.4) including loads at the hinge/attachment locations (defined as point forces or moments in any vehicle coordinate direction).

Figure 3.10a: Main Load Case GUI.
3.8.2 Distributed Wing Loads (Loading Spar): Note – See Section 5.0 for wing load methodology.

Load Case: Selecting loading to apply at the loading spar. Choose between: no loading (NONE), linear load distribution from the root to the tip (LINEAR), elliptical load distribution from the root to the tip (ELLIPTICAL), or Schrenk’s approximation from root to tip (SCHRENK’S).

Load Spar: Input the spar corresponding to the VSP spar number used as the loading spar for the selected load case.

Weight of Aircraft: Gross weight of the aircraft to be used to generate elliptical and Schrenk’s loadings. Use units consistent with other inputs.

Load Factor: Load Fact \( \eta_z \) or “g loading” that defines symmetric maneuver load case (i.e. symmetric 2-g pull up, input corresponds to a load factor of 2).

Root Load: For the linear load case, input the magnitude of the distributed load (in units of force per length) starting at the wing’s root. The load is applied along a load spar, typically located at the quarter chord. Be sure to use units consistent with the model and other inputs.

Tip Load: For the linear load case, input the magnitude of the distributed load at the tip.

Fixed End Moment: An additional external moment can be applied at the wing root (units of force \( \times \) length) about the root chord axis independent of the reaction moment. Be sure to use units consistent with the model and other inputs.

Side: Indicates whether the load is applied to the upper or lower wing surface.

Figure 3.10b: Load Case GUI inputs – Schrenk’s (Left) and Linear (right) inputs.
3.8.3 Surface Point Loads: Surface Point Loads can be applied anywhere on the Upper Surface or Lower Surface of the wing.

**Side:** Select the Radio Button corresponding to Upper Surface for upper surface point loads conditions or Lower Surface for lower surface point load conditions.

**Point Load ID:** If the Upper Surface is chosen, than the Point Load ID informs the user of the number of point loads for the surface and each point load parameters, likewise for Lower Surface. There is essentially an infinite number of point loads that can be applied.

**Load:** Input the point load in consistent units. The load is applied in the direction normal to the element surface.

**% Semi-Span:** Define the % half-span location of the current point load.

**% Chord:** Define the % chord location of the current point load.

**Add Point Load Button:** Once the user is done with the point load, then the user can press the add button to input another point load.

**Delete Point Load Button:** If the user input too many point loads or one of the point load’s parameters is wrong, then the user can delete the point load with the delete button and remove or redo it.

![Figure 3.10c: Load Case GUI inputs – Point Loads.](image)
3.8.4 Device Loads: are applied on or along the front and rear spars at previously trimmed locations, they need to be determined simultaneously with the device setting. There are three types of loading conditions: no loads, constant distributed loads, and point loads.

*No loads:* The no load case is used when the device carries no load.

*Constant Distributed Loads:* Defines the constant distributed linear load throughout the entire trimmed device. Use consistent Units.

*Point Loads:* Define the magnitude and direction of a point load.

*Load ID:* Keeps track of all the point loads on this trimmed device.

*Load:* Is the value of point load. Use consistent units.

*% Length:* Define the % length of the device for the point load.

*Direction:* Define the direction of the point load. Select between a force in the x, y, or z direction (F_{xx}, F_{yy}, F_{zz}) or a moment about the x, y, or z axes (M_{xx}, M_{yy}, M_{zz}). Apply multiple point loads in different directions at the same point to define a point load in any direction.

*Add Point Load Button and Delete Point Load Button:* section 3.8.3

![Load Case GUI inputs – Device Loading. Constant distributed load (Left). Point Loads (Center). No Loads (Right).](image)

**Note:** These values will not be saved when the Run Button is pressed. To save these values the save button must be pressed after all inputs are inserted.
3.9 Run VSP SAM – Click the Run button. Runtime will vary depending on the complexity of the model. Simple models typically run in 2 minutes or less.

3.9.1 Verifying Complete Run – In the current version of VSP SAM, the solution goes through multiple iterations to converge to the user defined Design Nominal Stress and user defined Mass Convergence criteria. The convergence process takes time and there are two ways to verify status of the solution.

a. In the current version of VSP SAM, you see status messages that indicate which processes are running in VSP SAM such as “Trim Op,” “Replication Op,” “Load Op,” as shown previously in Figure 3.2 (Left) on page 16. The GUI has a box for status messages next to “Run” and “Stop” buttons. However, the methods described in (b) and (c) can also be used to verify complete run.

b. In section 3.4, the user selects the folder where the VSP mesh is exported in Wing Path Tab. The same folder can be used to determine if the VSP SAM iterations are still running. If new files are created every few seconds, the solution is still running. Once VSP SAM is finished running no new files will be created.

c. See section 3.11 for a discussion on Mass Estimates generated by VSP SAM. While the iterations are still running, only the initial mass estimates window (figure 3.14 (Left)) will be visible. Once VSP SAM has finished running, the final mass estimates window (figure 3.14 (Right)) will be visible.

3.9.2 Running VSP SAM again – In the current version of VSP SAM, the iterative process creates several files in the folder selected in section 3.4 Wing Path Tab. In order to run VSP SAM again, the user must remove some specific files from that folder or use a different folder. Also, the user must close and reopen VSP SAM before running it again which is an issue we are working to resolve it in future updates. SECTION 2.6 ???

Files to keep: All files except 3 must be removed or moved to a location other than that selected in section 3.4. The 3 files must be retained are:

* Wingname_Calculix_geom.dat (section 2.6).
* Wingname_Calculix_thick.dat (section 2.6).
* Input file (section 3.3).

The rest of the files must be removed before running VSP SAM again.
3.10 Viewing Calculix Results. When the analysis is complete, the CalculiX post-processor will appear with the finished model and loads/stress/strains available for analysis, as shown in Figure 3.11.

Note: Several Calculix post-processor windows might open before the iterative process is complete. It is recommended that the user close the Calculix post-processor windows that appear before the final mass estimates window (figure 3.14 (Right)) appears. For further information refer to section 3.9.1.

a. Put the mouse cursor in the graphic display area, left-click to rotate the model, right click to translate the model, and use the scroll wheel to zoom in and out.
b. To adjust the viewing options, left-click anywhere on the border of the display (i.e. the whit part excluding analysis results labeled as “Datasets”, “Viewing” options, and the option to select the display “Orientation”.
c. The initial CalculiX display will show the geometry of the analyzed wing only. To return to this view at any point, left-click on the window, select the “Viewing option in the menu, and choose “Show All Elements With Light”.
d. To view stress distribution, left-click again in the white section, and highlight the “Datasets” option. In this menu, select the “STRESS” option. The menu will close after you click on “STRESS”. Left-click on the background to open the menu again, select “Datasets” again, and highlight the “-Entity-” option to access the menu for types of stresses to display, including principle stresses, von Mises stresses, and Tresca stresses. We select von Mises stress which is used by VSP SAM to calculate node thickness required to meet the user defined design nominal stress objective.

Figure 3.11: A finished CalculiX analysis showing stress results.
Using the same method, use the “Datasets” menu to view the displacements (in the x, y, z, or all directions), strains (principle, von Mises, Tresca), and external forces (x, y, z, or all directions).

Note - we have found CalculiX issues associated with viewing external force that we have been unable to resolve.

f. Left-click in the background area again, and select the “Viewing” option. The menu includes the options to:
   i. “Show All Elements With Light”: View the geometry of the model only.
   ii. “Show Bad Elements”: If there is an error in analysis, select this option to view the elements where failure occurred.
   iii. “FILL” shows the shaded model.
   iv. “LINES” shows the model as lines corresponding to the boundaries of elements. This view is useful for viewing internal stress distribution on the ribs and spars.
   v. “DOTS” shows the model as dots corresponding to the nodes of the elements.
   vii. “Toggle Vector-Plot”: Plot “needles” to point in the direction of the vectors to display the entity option selected.
   viii. “Toggle Add-Displacement”: Visually applied the displacement distribution to see the displacements.

g. Left-click in the background area again and go into the “Animate” menu. Select “Start” to animate the entity. Animation only works for deflections and external forces.

h. “Frame” is used to adjust the zoom automatically to fit the screen.

i. “Zoom is used to zoom in as an alternative to using the mouse scroll wheel.

j. See following section on successfully viewing internal stresses on a CalculiX model for a description of the “Cut” tool.

k. In the menu, select the “Orientation” option to select the view orientation. The options include “+x view”, “-x view”, “+y view”, “-y view”, “+z view”, and “-z view”. The x, y, and z orientation help view the spars, ribs, and skin surfaces, respectively.

l. See the following CalculiX website for more information on viewing options: http://www.bconverged.com/calculix/doc/cgx/html/cgx.html
3.10.1 Viewing CalculiX displayed internal structure.

Notation:
LMB = Left-mouse button
RMB = Right-mouse button
Menu: The menu is accessed by a left click on the “white area” outside the box inside which the wing is being displayed. Then proceed as below:

m. Choose an internal component to visualize (rib, spar, etc) as shown in Figure 3.12.

n. Go to: Menu → “Orientation” → “+z”

o. Go to: Menu → Viewing → Dots. Dots will draw the wing using dots allowing the user to view internal parts.

p. Zoom into and center onto the component you wish to visualize (two mouse buttons will be required: the RMB and the center scroll wheel).
   i. Zoom in by pressing down the scrolling wheel, and moving the mouse upwards (moving the mouse down, i.e. towards the user, zooms out).
   ii. Press the RMB to translate the model.

q. Go to Menu → Cut → Node 1 (the element edges will become visible on the model).
   i. Once the node is selected, the next mouse click will store it. Be careful not to press any mouse buttons until instructed to do so

r. Move the cursor to the wing and using LMB select an intersection of the elements (a node) which lies as close to the center of the desired wing component as possible.

s. Go to Menu → Cut → Node 2

t. Move the cursor to the wing and using LMB select an intersection of the elements which lies as close to the center of the desired wing component as possible. This must be a node different than the one chosen in step 6.

Figure 3.12: CalculiX results display.
u. Go to Menu → Orientation → -z (the model will flip).

v. Go to Menu → Cut → Node 3

w. Move the cursor to the wing and using LMB select an intersection of the elements which lies as close to the center of the desired wing component as possible.

x. Go to Menu → Viewing → Fill

y. Go to Menu → Datasets (select the desired data to display and click it).

z. Go to Menu → Datasets → Entity (choose the subset of the data to view).

aa. The data is now displayed for the desired component. However, the user may be required to move the model so that it can be seen. This can be done through the LMB (rotation), RMB (translation), scrolling wheel (zoom), or the orientation option in the menu (see step 2).

3.10.2 Viewing VSP SAM Results from multiple iterations – In the current version of VSP SAM, the iterative process goes through several iterations in order to converge to a user defined Design Nominal Stress and to meet user defined mass convergence criteria. As a result, several Calculix post-processor files mentioned in section 3.10 are generated in the folder selected in section 3.4 Wing Path Tab. It is possible to do a side-by-side comparison of the Calculix post-processor file generated at each iteration. An example of side-by-side comparison is shown in Figure 3.13a. Information on viewing Calculix post-processor files can be found in section 3.10 and section 3.10.1.

![Figure 3.13a: Calculix post-processor Side-by-side comparison: Initial iteration Stresses (Left). Final iteration Stresses (Right).](image)

Other comparisons such as comparison of displacement datasets between iteration 4 and iteration 5 can also be made. All the files are available in the folder selected in section 3.4 Wing Path Tab. An example of Calculix post-processor files is shown in Figure 3.13b. The files wing_initial and wing_final represents the Calculix post-processor files generated at the Initial and the Final iteration. The files wing1 to wing17 represent the Calculix post-processor files generated at the respective iterations. For example, wing3...
was generated at the third iteration. Clicking any of the files opens the Calculix post-processor. Several of them can be opened at a time to do a comparison. Information on viewing Calculix post-processor files can be found in section 3.10 and section 3.10.1.

<table>
<thead>
<tr>
<th>File</th>
<th>Date/Time</th>
<th>Type</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>wing_final</td>
<td>6/11/2013 4:53 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing_initial</td>
<td>6/11/2013 4:46 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing1</td>
<td>6/11/2013 4:48 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing2</td>
<td>6/11/2013 4:48 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing3</td>
<td>6/11/2013 4:48 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing4</td>
<td>6/11/2013 4:48 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing5</td>
<td>6/11/2013 4:49 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing6</td>
<td>6/11/2013 4:49 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing7</td>
<td>6/11/2013 4:50 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing8</td>
<td>6/11/2013 4:50 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing9</td>
<td>6/11/2013 4:50 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing10</td>
<td>6/11/2013 4:50 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing11</td>
<td>6/11/2013 4:51 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing12</td>
<td>6/11/2013 4:51 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing13</td>
<td>6/11/2013 4:51 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing14</td>
<td>6/11/2013 4:52 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing15</td>
<td>6/11/2013 4:52 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing16</td>
<td>6/11/2013 4:52 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
<tr>
<td>wing17</td>
<td>6/11/2013 4:52 PM</td>
<td>CCX Results</td>
<td>7,822 KB</td>
</tr>
</tbody>
</table>

Figure 3.13b: Calculix post-processor files in the folder selected in section 3.4 Wing Path Tab.
3.11 Mass Estimates. When finished viewing the CalculiX output, close the window.

a. The program will go through the mass generation method for a baseline mass calculation. The baseline calculations come from the user input thickness.

b. Next, VSP SAM will recalculate node thickness required to achieve the desired input design nominal working stress based on calculated nodal von Mises stress.

c. FEM mass is recalculated again using the design nominal stress based node thicknesses (section 6.2). The new mass estimate will be displayed as shown in Figure 3.14 and is recalculated until the user defined convergence criterion (section 3.6) is met.

![Figure 3.14: Mass Estimation Results: Initial (Left) and Calculated (Right).]
3.12 **Typical Run Times** vary with model complexity and mesh size and computer speed. The following time required to generate the ACT wing and run the VSP SAM solution is typical for a skilled VSP and VSP SAM user using a standard laptop or PC.

**VSP Wing Definition Time**
- Generate VSP external wing geometry 5 min.
- Generate VSP internal wing structure 5 min.
- Generate and export VSP mesh 2 min.

**Time** 12 min.

**VSP SAM Time**
- Define boundary conditions neg.
- Define trim conditions 5 sec.
- Define material properties 30 sec.
- Define spar, rib, and skin thickness 10 sec.
- Define loads 10 sec.
- Pre-processing 5 sec.
- Initial mass generation 30 sec.
- Initial Calculix iteration 1 min.
- Other Calculix iterations ≈ 4 min.
- Final mass generation 30 sec.

**Total** ≈ 8 min

**Total Time** ≈ 20 min

*Table 3.15: Run time for the ACT Wing Box.*
4.0 VSP SAM Issues and Cautions

4.1 Overall. The following is a list of currently known issues and cautions for VSP SAM users:

1. Running excessively large (> 5 Mb) VSP mesh files significantly increases run time and in some cases will cause a memory allocation failure when running CalculiX. Simplification of the model or a larger mesh will be required to fix the problem.

2. VSP SAM must be run in VSP consistent units (i.e. if the VSP model is defined in feet, then all inputs must be in feet to include material properties and allowables).

3. Wing trim is restricted to defined spar and rib locations. For a trim to take place a leading edge and/or trailing edge spar must exist and ribs located at span-wise trim locations must exist, unless the entire leading edge/trailing edge is trimmed.

4. A paper spar may be defined for the loading spar if the user wishes to apply a line load where a par does not physically exist.

5. Up to four materials may be defined by the user and applied to four structural component types (spar, ribs, skins, and load spar). Future releases may have a larger material library to include orthotropic and composite materials.

6. Point loads on the upper and lower surfaces of the wing can be defined only the direction normal to the element surface as a load across an entire element. Along the trim devices, however, the point loads can be applied to elements as forces in the x, y, or z direction or moments in the x, y, or z direction. Future releases will accommodate applied forces in x, y, and z directions along spars and ribs.

4.2 Structural Sizing Methodology Limitations

Users are cautioned that the practical results of the static FEM stress based sizing methodology developed for VSP SAM is a highly idealized structural representation of a wing or empennage component. The FEM model makes no allowance for fasteners, damage tolerance, fatigue or other “real world” effects. In its current form, the model also does not address buckling; although, we have an initiative under way to do so. Sizing is also based on a single load case, which is another issue that will be addressed by future releases. In essence, the sizing methodology generates a purely static stress based, idealized structure that requires application of a significant design nominal stress “knock down” to account for factors not included. Research currently underway at UT will provide quantitative guidance on recommended known down factors. In the meantime, users are advised to limit application of the methodology to trade studies that are performed around well-developed structural baseline representations.

Other limitations in the current methodology include:

Above the elastic range of the material, the stresses calculated by the FEM analysis are invalid and local yielding will occur to redistribute the internal loads. Our current thickness methodology analysis does not make allowance for abnormally high localized...
stresses. A refined methodology is under development and will be described in the future releases of VSP SAM.

The current thickness sizing methodology is based on a multiple sizing iteration and represents a converged stress solution since stress changes will result from redistribution of internal loads.

Multiple design load case analysis is required to size realistic structure. Load cases are typically not additive and require multiple sequential load case analyses for sizing. Methodology for multiple load case analysis is under development.

Rib-rib and spar-spar defined bays are not sized for buckling. Methodology is under development to include buckling in the sizing methodology.
5.0 Load Case Methodology

5.1 Overview

Simple conceptual design (CD) level running loads (force/unit length) are defined consistent with established conceptual sizing methodology. Running loads are typically applied at a 0.25 chord fraction line but in VSP SAM they can be applied along any chord fraction. Three (3) types of running loads can be applied including linear, elliptical, and Schrenk’s approximations. Linear loads are defined in consistent units of force/unit length. Elliptical and Schrenk load approximations are defined by air vehicle weight and load factor and are intended for use primary on wing load carrying surfaces. Empennage structure, however, can also be analyzed if tail loads are defined by appropriate fractional g-loads based on vehicle weight, e.g. 0.1 to 0.2 for a typical horizontal tails.

Other load conditions include point loads (forces and moments) and linear running loads at spars between defined trim rib locations. Point loads are currently not provided to preclude point load application at skin locations with no backup structure. Pseudo point loads, however, can be applied across a single element as a distributed load, but only normal to the element surface. Both the point and element distributed load methods are assumed to be well understood by users, and the remainder of this section will focus on linear, elliptical and Schrenk running load approximations.

5.2 Linear Running Loads are the simplest approximations typically used for conceptual level structural analysis. Linear loads can provide a reasonable approximate load case for horizontal and vertical empennage structure and/or winglets.

The linear load case is defined by the distributed root and tip loads (force per length) input by the user. These loads are then used to calculate approximate point loads for each node along the specified spar. This is accomplished by calculating the equivalent force due to the distributed load from midpoint between the node inboard to the midpoint between the node outboard from the node for which the load is being calculated.

Figure 5.1: Linear load distribution.
5.3 Elliptical Loading Approximation. Elliptical load approximations are standard practice for conceptual-level modeling of static wing loads at a defined normal load factor \( (n_z) \). The load is typically applied along the wing quarter chord, but it is not required in VSP SAM (any constant chord line can be defined). The magnitude of the elliptical load is calculated from aircraft weight and load factor as described below. Loads are converted to equivalent forces at defined node locations and averaged across adjacent elements.

![Figure 5.2: Elliptical load distribution.](image)

VSP wing models are defined in symmetrical left and right hand pairs, and Figure 5.2 shows a half-span representation with an elliptical running load, where the maximum is at the root and goes to zero at the tip. For a given air vehicle of gross weight \( (w) \) at a constant defined load factor \( (n_z) \) the equation for an elliptical distribution for the semi-span is given as

\[
l = \frac{2 \cdot w \cdot n_z}{\pi \cdot \left(\frac{b}{2}\right)} \sqrt{1 - \left(\frac{y}{\frac{b}{2}}\right)^2}
\]

where
- \( l \) is the distributed load (force per length)
- \( b \) is the total wing span (length)
- \( y \) is span location (length)

From the defined elliptical distribution, point loads are calculated for each node along the specified spar. The running load is converted to equivalent forces acting on nodes.

5.4 Schrenk’s Approximation is a semi-empirical span-wise load distribution for non-elliptical wing planforms. The method assumes the load distribution is equivalent to the average of the elliptical load distribution and the actual planform shape distribution of the wing. The method requires calculation of the average of the chord variation and the elliptical load variation at a defined span location, as shown in Figures 5.3 below, for rectangular and trapezoidal planforms. Similar to elliptical load distributions, Schrenk loads are typically applied along the quarter chord line, but it is not a VSP SAM requirement.
Mathematically, the span-wise load is given by:

\[
l = \frac{w \cdot \eta_Z}{2 \cdot \left( b \right)} \left( \frac{1}{2(1 + \lambda)} + \frac{1}{\pi} \right) \left( 1 + (\lambda - 1) \cdot \frac{y}{b/2} + \sqrt{1 - \left( \frac{y}{b/2} \right)^2} \right)
\]

where:
- \( l \) is the distributed load (force per length)
- \( w \) is the aircraft weight (force)
- \( \eta_Z \) is the load factor (nd)
- \( \lambda \) is the taper ratio (nd), defined as tip chord divided by root chord
- \( b \) is the total wing span (length)
- \( y \) is the span location normal to the wing centerline (length)
6.0 Thickness Sizing Methodology

6.1 Overview

A simple static stress-based structural thickness methodology is used to size FEM components to achieve an overall input design nominal stress level across the model. Thickness sizing is based on FEM calculated nodal von Mises stress. The method is applied to node, instead of element, thickness to avoid thickness discontinuities between elements. Design nominal stress objectives are currently input for three (3) classes of structural components (spars, ribs and skins). Minimum gage thickness constraints are also defined. The current version of VSP SAM does one thickness sizing iteration at the end of a single CalculiX stress solution. Future versions will iterate solutions to convergence. The current sizing methodology produces a highly-idealized static stress sized model suitable for structural trade studies. If used for point design analysis, users are cautioned to use significant design nominal stress knock-down factors to account for real-world design considerations not currently included in the methodology.

6.2 Node Thickness Sizing Methodology

VSP FEM methodology sizes the FEM model to achieve a constant overall design nominal stress level across the structure. The VSP SAM FEM model is based on shell elements of fixed grid size where, by definition, structural components are one (1) element thick. Stress sizing, therefore, reduces to a single design variable, thickness. The stress sizing method compares the FEM calculated von Mises stress at each node to the input design nominal working stress objective and recalculates node thickness to achieve the desired stress level.

Thickness required to achieve a desired stress level at any element node of known thickness \( t_1 \) for an arbitrary 3D element is defined by the ratio of the calculated stress \( \sigma_1 \) to a desired node stress objective \( \sigma_{obj} \). The basis for the relationship is shown in Figure 5.1 and is derived below:

![Figure 6.1: 3D element with a plane on a principal stress axis.](image)

The blue plane represents a plane lying in one of the 3 principal stress axes, showing that the element can be arbitrarily oriented. The stress acting on the plane, which has a defined area and length \( L \), is defined by the relationship:

\[
\sigma_1 = \frac{\text{Force}}{\text{Thickness}_1 \cdot L}
\]
Since element length is defined by input mesh size and the force is defined for the node, we see that $\sigma_1 \propto 1/t_1\text{ or } \sigma_1 t_1 = \text{constant}$ and the thickness ($t_1$) associated with a given stress ($\sigma_1$) is related to any other stress and thickness combination ($\sigma_2, t_2$) by

$$\sigma_1 \cdot Thickness_1 = \sigma_2 \cdot Thickness_2$$

Therefore, node thickness required to achieve a design nominal stress objective $\sigma_2 = \sigma_{obj}$ is given by

$$Thickness_2 = \frac{\sigma_1 \cdot Thickness_1}{\sigma_{obj}}$$

The thickness relationship is valid anywhere within the elastic range of the material. At low stress levels, however, node thickness will be defined by material minimum gage, which is another required material property input.

6.3 Thickness Methodology Limitations

Users are cautioned that the practical result of the static FEM stress based sizing methodology described above is a highly idealized structural representation of an airframe component. The FEM model makes no allowance for fasteners, damage tolerance, fatigue or other "real world" effects. In its current form it also does not address buckling; although, we have an initiative under way to do so. Sizing is also based on a single load case, which is another issue that will be addressed by future releases. So in essence, the sizing methodology generates a purely static stress based, idealized structure that requires application of a significant design nominal stress "knock down" factors to account for factors not included. Research currently underway at UT will provide quantitative guidance on recommended knock down factors. In the meantime, users are advised to limit application of the methodology to trade studies that are performed around well-developed structural baseline representations.

Other limitations in the current methodology include:

Above the elastic range of the material, the stresses calculated by the FEM analysis are not valid and local yielding will occur to redistribute the internal loads. Our current thickness methodology analysis does not make allowance for abnormally high, localized stresses. A refined methodology is under development and will be described in future releases of VSP SAM.

The current thickness sizing methodology is based on a multiple sizing iteration and represents a converged stress solution since thickness changes will result in a redistribution of internal loads.

Multiple design load case analysis is required to size realistic structure. The load cases are typically not additive and require multiple sequential load case analyses sizing. Methodology for multiple load case analysis is under development.

Rib-rib and spar-spar defined bays are not sized for buckling. Methodology is under development to include buckling in the sizing methodology.
7.0 Mass Estimation Methodology

7.1 Overview

VSP SAM estimates structural mass from finite element model (FEM) volume and input material density. Spar, rib and skin FEM volumes are calculated separately based on the sum of the mesh elements for each part component class. Element volume is defined by the thickness of the nodes that define each element. Node thickness is calculated as described in Section 5.

7.2 Element Volume

The VSP generated mesh, as input to VSP SAM, is a zero-thickness surface to which a user input thickness distribution is applied across nodes. The starting FEM mass, therefore, is a little more than a calculated value that reflects user defined estimates of node thickness required to react internal loads (stresses) or to meet deflection requirements. After the first von Mises stress calculation, node thickness required to meet input defined nominal stress objectives are calculated and the volume of the resulting FEM model will represent the amount of material required to meet structural requirements.

FEM mesh elements can be either triangular or trapezoidal shape, as defined by VSP. From the VSP defined shape, the area of each element can be calculated using standard method for any arbitrary triangle or rectangle given by:

\[
\text{Area}_{\text{triangle}} = \frac{1}{2} |v_{01} \times v_{02}| \\
\text{Area}_{\text{rectangle}} = \frac{1}{2} |v_{01} \times v_{02}|
\]

where \(v_{01}\) and \(v_{02}\) are the position vectors between two points using x, y, and z coordinates.

From these areas, the volume is calculating by multiplying the element area by the average thickness for the element. Using the user-defined material densities from the inputs, the masses are then generated.

\[
\begin{align*}
\text{Vol}_{\text{triangle}} &= \text{Area}_{\text{triangle}} \times \left(\frac{t_0 + t_1 + t_2}{3}\right) \\
\text{Vol}_{\text{rectangle}} &= \text{Area}_{\text{rectangle}} \times \left(\frac{t_0 + t_1 + t_2 + t_3}{4}\right) \\
\text{Mass}_{\text{component}} &= (\text{Vol}_{\text{triangle}}_{\text{component}} + \text{Vol}_{\text{rectangle}}_{\text{component}}) \times \text{density}_{\text{component}}
\end{align*}
\]
8.0 Appendix

8.1 Verification of CalculiX Results:

A VSP wing is generated with a rectangular airfoil and analyzed as a rectangular cross-section beam. The wing is analyzed as a cantilever rectangular beam loaded along the 50% chord line and fixed at the root rib.

The cross sectional geometry is shown below.

Figure 8.1: Rectangular Cross-Section Beam with geometric definitions.
The stress results generated by CalculiX are shown below.

Figure 8.2: Top view of beam with stress results in CalculiX.
Figure 8.3: Spar (left) and root (right) view of beam with stress results in CalculiX.

The cross-sectional area (excluding ribs) is found to be:

\[ A = (2)(0.05 \text{ in})(2 \text{ in}) + (3)(0.05 \text{ in})(0.5 \text{ in} - 2 \cdot 0.05 \text{ in}) = 0.26 \text{ in}^2 \]

The moments of inertia are:

\[
I_{xx} = \frac{1}{12}(2 \text{ in})(0.5 \text{ in})^2 - \frac{1}{12}(2 \text{ in} - 2 \cdot 0.05 \text{ in})(0.5 \text{ in} - 2 \cdot 0.05 \text{ in})^2
\]

\[
+ \frac{1}{12}(0.05 \text{ in})(0.5 \text{ in} - 2 \cdot 0.05 \text{ in})^3(3) = 0.0115 \text{ in}^4
\]

\[
I_{yy} = \frac{1}{12}(0.5 \text{ in})(2 \text{ in})^2 - \frac{1}{12}(0.5 \text{ in} - 2 \cdot 0.05 \text{ in})(2 \text{ in} - 2 \cdot 0.05 \text{ in})^2
\]

\[
+ \frac{1}{12}(0.5 \text{ in} - 2 \cdot 0.05 \text{ in})(0.05 \text{ in})^3(3) = 0.105 \text{ in}^4
\]

For a linearly distributed load with root distributed load of 10 lb/in and a tip distributed load of 5 lb/in, the reaction forces and moments are:

Vertical (z-axis) shear reaction force:

\[ R_z = \left(5 \frac{lb}{in}\right)(10 \text{ in}) + \frac{1}{2}\left(10 \frac{lb}{in} - 5 \frac{lb}{in}\right)(10 \text{ in}) = 75 \text{ lb} \]

Reaction moment about the chord-wise axis (x-axis):

\[ M_{xx} = \left(5 \frac{lb}{in}\right)(10 \text{ in})(5 \text{ in}) + \frac{1}{2}\left(10 \frac{lb}{in} - 5 \frac{lb}{in}\right)(10 \text{ in})\left(\frac{1}{3}\right)(10 \text{ in}) = 333.33 \text{ lb} - \text{in} \]

The beam is symmetrical and loaded along the span-wise centerline, so there is no torsion stress in the system. The internal stresses on the skin at the root rib are found as:

\[ \sigma_{\text{shear}} = \frac{F}{A} = \frac{75 \text{ lb}}{0.26 \text{ in}^2} = 289 \text{ psi} \]

\[ \sigma_{\text{bending max,xx}} = \frac{M_{xx}}{I_{xx}} = \frac{(333.33 \text{ lb} - \text{in})(0.5 \text{ in})}{0.0115 \text{ in}^4} = 7.3 \text{ ksi} \]

\[ \sigma_{\text{max root}} = 7.5 \text{ ksi} \]

At the 25% semi-span, the internal loads are:
Vertical (z-axis) shear reaction force:
\[
R_z = 75 \text{ lb} - \left(8.75 \frac{\text{lb}}{\text{in}} \cdot 2.5 \text{ in}\right) + \frac{1}{2} \left(10 \frac{\text{lb}}{\text{in}} - 8.75 \frac{\text{lb}}{\text{in}}\right) \cdot 2.5 \text{ in} = 51.6 \text{ lb}
\]

Reaction moment about the chord-wise axis (x-axis):
\[
M_{xx} = \left(5 \frac{\text{lb}}{\text{in}} \cdot 7.5 \text{ in}\right) \cdot 3.75 \text{ in} + \frac{1}{2} \left(8.75 \frac{\text{lb}}{\text{in}} - 5 \frac{\text{lb}}{\text{in}}\right) \cdot 7.5 \text{ in} \cdot \frac{1}{3} \cdot 7.5 \text{ in} = 175.8 \text{ lb} - \text{in}
\]

At the 50% semi-span, the internal loads are:
Vertical (z-axis) shear reaction force:
\[
R_z = 75 \text{ lb} - \left(7.5 \frac{\text{lb}}{\text{in}} \cdot 5 \text{ in}\right) + \frac{1}{2} \left(10 \frac{\text{lb}}{\text{in}} - 7.5 \frac{\text{lb}}{\text{in}}\right) \cdot 5 \text{ in} = 31.3 \text{ lb}
\]

Reaction moment about the chord-wise axis (x-axis):
\[
M_{xx} = \left(5 \frac{\text{lb}}{\text{in}} \cdot 5 \text{ in}\right) \cdot 2.5 \text{ in} + \frac{1}{2} \left(7.5 \frac{\text{lb}}{\text{in}} - 5 \frac{\text{lb}}{\text{in}}\right) \cdot 10 \text{ in} \cdot \frac{1}{3} \cdot 5 \text{ in} = 64.6 \text{ lb} - \text{in}
\]

The internal stresses on the skin at the 25% semi-span are found as:
\[
\sigma_{\text{shear}} = \frac{F}{A} = \frac{51.6 \text{ lb}}{0.26 \text{ in}^2} = 198 \text{ psi}
\]

\[\sigma_{\text{bending,max,xx}} = \frac{M_{xx}y}{I_{xx}} = \frac{(175.8 \text{ lb} - \text{in}) \cdot (0.5 \text{ in})}{0.0115 \text{ in}^4} = 3.8 \text{ ksi}\]

\[\sigma_{\text{max,root}} = 4.0 \text{ ksi}\]

The internal stresses on the skin at the 50% semi-span are found as:
\[
\sigma_{\text{shear}} = \frac{F}{A} = \frac{31.3 \text{ lb}}{0.26 \text{ in}^2} = 120 \text{ psi}
\]

\[\sigma_{\text{bending,max,xx}} = \frac{M_{xx}y}{I_{xx}} = \frac{(64.6 \text{ lb} - \text{in}) \cdot (0.5 \text{ in})}{0.0115 \text{ in}^4} = 1.4 \text{ ksi}\]

\[\sigma_{\text{max,root}} = 1.5 \text{ ksi}\]
8.2 Verification of mass generation results:
The volume is calculated as

\[ V = A_{\text{skin}} t_{\text{skin}} + A_{\text{spar}} t_{\text{spar}} + A_{\text{rib}} t_{\text{rib}} \]
\[ = (2)(2 \text{ in})(10 \text{ in})(0.05 \text{ in}) + (3)(0.5 \text{ in})(10 \text{ in})(0.05 \text{ in}) + (5)(2 \text{ in})(0.3 \text{ in})(0.05 \text{ in}) \]
\[ = 3 \text{ in}^3 \]

The material is defined as aluminum, so the density of the material is \( \rho = 0.1 \frac{\text{lbm}}{\text{in}^3} \). The mass of the beam is then found to be

\[ m = V \rho = (3 \text{ in}^3)(0.1 \frac{\text{lbm}}{\text{in}^3}) = 0.3 \text{ lbm} \]

Figure 8.4: Mass generation results from the VSP to CalculiX software.